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Introduction 

We’ve all heard the buzz about email marketing and how cost-efficient and easy 
it is to do. This guide will help you get started with your own program quickly and 
easily. 

For example, Tara Bella Winery, which sells high-end wines, used Winery Pro, a 
FileMaker Pro email marketing solution to send an email to its customer base 
about a special wine package. Within 24 hours, they had sold out the inventory 
and grossed $8,500. Time spent writing the email and sending it out? Less than 3 
hours!

Email marketing helps businesses see instant sales from existing customers, as 
in Tara Bella’s case, but more importantly, it maintains and builds long-lasting 
relationships with loyal customers - which are the core of most successful 
businesses.

Despite the business benefits of email marketing, many businesses are either still 
not using it or they are under-utilizing its power. 

If you’re already marketing via email, this guide provides useful tips to improve the 
results of your email campaigns and ideas to build long-term relationships with 
loyal customers. 

For those of you who haven’t started email marketing, you’ll learn how to do it 
efficiently and effectively - the right way -  with the right tools.

The right way is sending compelling emails to customers and prospects that want 
to hear from you and have given you permission to contact them.

The right tools are at your fingertips and easy enough for anyone to use – as long 
as you have an email account, an Internet connection and a Windows or Mac OS 
computer.

So let’s do it the right way with the right tools starting with Step #1: Consolidating 
Your Names
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1.	 Consolidating Your Names
If you’re like many small businesses, you have names in many different programs 
and places – from your email address book, to accounting software, from handheld 
devices to Excel spreadsheets – not to mention all the paper sticky notes on your 
desk and monitor, or last year’s sales orders in the file cabinet. 

This step is all about gathering names and getting them into an easily accessible, 
centralized location.  Can you really have all your names in one place? Yes, you 
can!  And it’s not hard if you follow the steps below.

The first thing you need is a database program.
•	 Having an easy-to-use database that contains all your names and email 

addresses is the key to any successful, long-term email marketing and 
relationship building program. 

•	 Whether you use FileMaker Pro or another program, you need a database 
that you can use by yourself without having a degree in computer 
programming.  You need one that you can customize to meet your unique 
needs and that grows with your business.  

There are a few ways that you can consolidate your names into one place, but to 
make it as simple as possible for you, we recommend that you download and 
install the FileMaker Pro trial and the FileMaker Business Productivity Kit if you 
haven’t already (available at www.filemakertrial.com/bpk), and follow the steps 
below.

•	 If all your names are on paper forms or in your trusty Rolodex®, this is the 
part where you (or your teenager) start typing. When you’re finished, you 
can skip to Step 2.

If you’re lucky enough to have your names already entered into Microsoft Excel, 
Microsoft Outlook, Microsoft Entourage, Palm Desktop, Intuit QuickBooks or 
another software program, you can minimize the tedious task of data entry by 
exporting your contact information from these programs and importing it into 
FileMaker Pro.

To get started, you’ll want to export your contact information into a format that 
FileMaker Pro can read, such as Microsoft Excel (.xls or .xlsx), or a Comma/Tab 
Delimited Text file (.csv or .txt). 

Once you export your names, you can simply import them into the FileMaker Pro 
Contacts database that comes with the FileMaker Business Productivity Kit.  

If you’d like step-by-step instructions for exporting and importing contact 
information, please see Appendix 1: Exporting and Importing Instructions. 		

Try This:  
To get started quickly, 
download the FileMaker 
Business Productivity 
Kit and free 30-day trial 
of FileMaker Pro from 
www.filemakertrial.com/
bpk. All you have to do 
is start entering data 
into the pre-designed, 
ready-to-use databases 
for contact management 
and email marketing, as 
well as tracking inventory, 
processing sales orders, 
and managing projects. 
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2.	 Build Your List of Email Addresses
You can’t do much email marketing unless you have email addresses of people 
who want to hear from you and have given you permission to contact them via 
email.

Building your own list of current customers, past customers, and prospects (versus 
buying names and addresses) is the best way to start an effective e-mail marketing 
list. 

If you completed Step 1, you now have your existing names in a database.  But up 
until now, you haven’t had much need for email addresses, so chances are that you 
have a big blank in the email address field for many of your customers.  

What you want to do now is fill in those empty fields, in addition to adding new 
names and email addresses.  Here are some ideas to get you started.

•	 Use your website, storefront, front desk, and every phone call as an 
opportunity to gather permission to email your customer. You want to 
provide something to which your current and potential customers will say, 
“Yes, I give you permission to send me email.”  A simple clipboard on your 
front counter or form on your website, that says “Sign up here to receive 
discount coupons via email!” or “Sign up here to get our free Newsletter via 
email!” will get you going.

•	 Make sure you provide a column for their name and a plenty of room 
for long email addresses. It’s really disappointing to fill out a form that 
asks for email address that allows less than an inch to write it in; please 
don’t make this mistake!

•	 Don’t ask for too much information at first.  All you need to get started 
is first name and an email address.  You can ask for more information such 
as last name, company, and phone number, and hope people fill it out, but 
don’t make it a requirement for someone to say, “Yes” to your offer.

•	 And most-importantly, privacy.  You should develop a privacy statement 
that communicates to customers how your company uses their personal 
information.  You should post your privacy statement on your website and 
make it available to your customers.  For additional information and privacy 
resources you can visit www.privacy.org or www.truste.org.

Try This:  
If you have mailing 
addresses, but not a lot of 
email addresses, try sending 
a paper postcard to your 
customers in the mail.  Ask 
for their email address in 
exchange for a free gift 
or dollars off their next 
purchase.  You can even 
offer a great prize in monthly 
drawing, and the only way 
to enter is by sending you 
an email with their contact 
information. 

Simply ask the postcard 
recipients to send you an 
email containing their name 
and address to enter the 
drawing.  As the emails 
come into your inbox, 
simply cut and paste the 
email address from your 
customers’ emails into their 
corresponding contact 
record in FileMaker Pro. 

You can also use FileMaker 
Pro to print your postcard 
mailing labels choosing 
from more than hundred 
Avery labels sizes, or you 
can use a service, like 
VerticalResponse (www.
verticalresponse.com) to 
print and send the postcards 
for you.

If you don’t have any current 
customers or prospects, 
try keyword advertising on 
Google.com or purchase 
an opt-in email list from a 
respected provider.  This 
will cost you some money 
and time, but if you have 
no other options, it will help 
get your mailing list started. 
For more details on keyword 
advertising and purchasing 
mailing lists, see the 
resources listed at the end of 
this article.
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3.	 Develop Your Email Campaign Mix
Decide on Content & Frequency

There’s a delicate balance between too much and not enough email 
marketing in order to maintain and build long-lasting relationships.  
Combining a variety of content at different intervals is acceptable to most 
customers who have opt-ed in to your email list. You don’t want every 
email that you send to be promotional.  You want a blend of editorial and 
promotional communication that will help you build a long-lasting relationship 
with your loyal customers. 

In order to decide on the mix, figure out what you think will help build your 
relationship with current customers, win back lost customers, and move hot 
prospects closer to becoming customers.  Ask yourself these questions for 
customers and prospects — to help decide on your unique email campaign 
mix for the different groups you’re targeting.

1.	 What type of content would my customers/prospects appreciate  
from me? 

2.	 What would they read and respond to? 

3.	 What would help build my relationship with them?  

4.	 Do they want informative news-like, editorial content?

5.	 Do they want entertaining emails and jokes?

6.	 Do they need notification of policy renewals and contract expirations?

7.	 What about urgent updates and product recall information?

8.	 Do they want price change alerts or notifications of promotional offers 
and discounts?

9.	 Do they want order confirmations sent through email? Or if I’m already 
sending transactional email like order confirmations, can I add upsells 
and other marketing messages to those?

10.	 Would they appreciate a casual greeting regarding a special day, such a 
birthday, anniversary or upcoming party?

Would a combination of any of these types of communication be appropriate?  If 
so, you can send emails at different intervals for different topics.

It’s simple: LOYAL RELATIONSHIPS will give you the competitive edge!

Try This:  
If all the questions have 
your head spinning, it’s ok.  
To get started with a nice 
balance of communication, 
start with 3 simple 
”channels.”  Your recipients 
will tell you if they want 
more or less of each type.
1.	 A monthly newsletter 
2.	 A quarterly special offer 
3.	 An annual Customer 

Appreciation invitation.
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4.	 Write Your Email
Open the Email Marketing Database

Once you have your email campaign mix figured out, writing your first email 
will be easy using the 30-day trial of FileMaker Pro and the email marketing 
database that comes in the FileMaker Business Productivity Kit available at www.
filemakertrial.com/bpk.

Follow these steps to develop your first campaign:
Open the file called bps_Main_Menu.
fp7 that is in the BPK_3.0 folder 
that’s part of the FileMaker Business 
Productivity Kit you downloaded. 
Click on Email to open the pre-
designed email marketing database.

Try This:  
1.  Write short paragraphs and link to your website for longer articles or have 

customers call to learn more. If your stories are too long, no one will read them.
2.  Treat your current customers differently than prospects. Make sure they feel 

special by sending slightly different emails to current customers vs. future or 
past customers.

3.  The Subject line is important.  With junk mail filters on almost every inbox, 
be sure you’re not too aggressive with promotional terms, capitalization and 
exclamations. If you have something free to offer, it’s ok to include the word 
“Free” in your subject line, but make sure it doesn’t end up in your customers 
“junk folders” by testing a few messages with friends and coworkers first. Be sure 
that you send from a new email address, such as (eNews@yourdomain.com) that 
hasn’t already been added to their address book.
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First we need to define the first 
Campaign, which is our monthly 
newsletter, for this example. 
Enter the Campaign Name: Monthly 
Newsletter

Mark Status to Open.
Then, add a description if you choose. 
Adding a description is handy so that if 
anyone ever needs ideas for writing the 
newsletter, the outline of what should 
be included will be detailed right on-
screen.

Click on the Template tab. This is where 
you’ll enter your email text. See below 
for some hints to help you get started.

Enter the Text of your Email 
•	 The text of your email is critical.  Make sure your copy gets right to the point 

with compelling content, special offers, or exciting news.  You’ll find some 
examples of different styles of emails to help you get started below. 

•	 Make sure you take advantage of the ability for FileMaker Pro to merge 
fields from your database into the email text. To make your emails more 
personalized for your recipients, click on a field button located on the left 
sidebar of the Template Tab.
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Here’s an example of one way that you might start with your first monthly 
newsletter:

Dear <First Name>,

You are receiving this newsletter because you, or someone using this 
email address, subscribed to the Big Mountain Bikes Cycle Update.

We have a lot fun and exciting events coming up soon so be sure to 
mark your calendar for these activities:

1. Add event details here.
2. Add event details here.
3. Add event details here.

Check out our new website at http://www.bigmountainbikes.com for 
complete results and great pictures from recent events. You can even 
sign up for next month’s triathlon online!

**Patrick Thomas wins iPod**
Congratulations to this month’s iPod Nano winner:  Patrick Thomas 
of Great Falls.  If you or any of your friends want to enter for 
next month’s iPod drawing, visit the store or website at http://www.
bigmountainbikes.com to sign up. Feel free to forward this email to 
your friends so they can sign up too!

**Last Chance for Free Tune Up** Get a free tune up with any 
purchase over $25.00 made before the end of month. Stop in or 
schedule an appointment today! Call us at 406-555-1234.

Next month, check out:
*Moab at Midnight – pics and tricks from Ken Buchholz
*Ratings on New Gear for 2009 – what’s hot and what’s not
*Results from the Big River Triathlon 

Happy Riding, 
The Team at Big Mountain Bikes

**************
This email is being sent from Big Mountain Bikes, 1234 Main St., 
Whitefish, MT 93446.

You are receiving this email because you or someone used this 
email address to subscribe to this email. To unsubscribe from this 
email, please reply with REMOVE in the subject line to discontinue 
receiving Monthly Newsletters via email from us.
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Here’s an example of a quarterly special offer email if you’d like your emails to be 
more offer-based to generate business right away.

Dear <First Name>,

You are receiving this newsletter because you, or someone using this 
email address, subscribed to the Big Mountain Bikes Special Offers 
email.

These special offers are made exclusively to Big Mountain Bikes’ 
best customers so take advantage of them while you can because they 
won’t last long!

**Free Tune Up**
Get a free tune up with any purchase over $25! That’s a $69 value 
absolutely free when you buy any item in the store or on the website 
for $25 or more. Stop by or call 800-555-1234 to schedule your free 
tune up!

**Buy One, Get One Free**
It’s BOGO time on key items you need for Fall! Get FREE jerseys, 
rims, tires, pedals, saddles and more, when you buy an identical 
item at the regular price. See store or website for details. Hurry! 
This offer expires at the end of this month.

Check out the website at http://www.bigmountainbikes.com/offers for 
even more special offers exclusively for our favorite customers like 
you, <First Name>.

Happy Riding, 
The Team at Big Mountain Bikes

**************
This email is being sent from Big Mountain Bikes, 1234 Main St., 
Whitefish, MT 93446.

You are receiving this email because you or someone used this 
email address to subscribe to this email. To unsubscribe from this 
email, please reply with REMOVE in the subject line to discontinue 
receiving Special Offers via email from us.
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Here’s an example of a customer appreciation email that you can send to valued 
customers to help maintain and build your relationships.

Dear <First Name>,

You’re invited to our Customer Appreciation Open House!

As our way of saying “Thank You” for your business over the years, 
please let us treat you to a gourmet lunch prepared by Bozeman 
Bistro owner and chef, Philippe Rothschild. 

What:  Customer Appreciation Open House and Luncheon
Date:	 December 15, 2009
Time:	 11am to 2pm
Where: Big Mountain Bikes Main Store, 1234 Main St.
RSVP:  Call 555-1234 or email: tom@bigmountainbikes.com

You’ll also get big discounts on everything in the store, plus get a 
chance to win a new mountain bike, a $1000 value!

I hope to see you there,
 - Tom

**************
This email is being sent from Big Mountain Bikes, 1234 Main St., 
Whitefish, MT 93446.

You are receiving this email because you or someone used this 
email address to subscribe to this email. To unsubscribe from this 
email, please reply with REMOVE in the subject line to discontinue 
receiving Customer Appreciation emails from us.
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Here’s an example of a birthday email  - who wouldn’t appreciate you after  
getting this?

Happy Birthday <First Name>!

I wanted to take a few minutes to wish you a very Happy Birthday!

You’ve been a valued customer for many years, and my business 
wouldn’t be the same without your support.  

As a small “thank you,” you can get $50 off any item between now and 
the end of the month.  Just bring this email into the shop, or if 
you order from the website, enter “Bday” in the Promo Code field to 
get your discount.

I hope this day brings you great happiness and joy, and I hope to 
see you again soon! 

Yours truly,
 - Tom
**************
This email is being sent from Big Mountain Bikes, 1234 Main St., 
Whitefish, MT 93446.

You are receiving this email because you or someone used this 
email address to subscribe to this email. To unsubscribe from this 
email, please reply with REMOVE in the subject line to discontinue 
receiving Special Greetings from us.
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5.	 Choose Your Recipients
This is where you’ll choose which customers or groups of customers are 
selected to receive this particular email. See below for some hints to help you 
get started.

Click on the Recipients Tab and choose 
Add Contacts. Click on the red arrow to 
the left of each name that you wish to 
add to the recipient list.

As you select names, you will see them 
added to the main recipient list.  This 
may take a while if you have a lot of 
names. So please see the note below 
about creating Groups to make selecting 
recipients go much faster.

Click back to the Detail tab, to confirm 
everything looks good, but don’t click 
the Send button just yet.

Note: Using this method, will place the 
emails in your Drafts folders, until you 
choose to send them from your email 
client.

FileMaker Pro also offers another option 
for sending email without requiring the 
use of an email client.  To learn more 
about sending email directly via SMTP, 
please visit www.filemaker.com.
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Things You Must Do
1.	On December 16, 2003 the Controlling the Assault of Non-Solicited 

Pornography and Marketing Act of 2003 (CAN-SPAM Act) was signed into 
law. It establishes a framework of administrative, civil, and criminal tools 
to help America’s consumers, businesses, and families combat unsolicited 
commercial email, known as spam. 

2.	While your email to your customers, is not technically spam because your 
customers have requested to be added to your list, you should always do 
these two things when sending email.

-	 Include your organization’s physical mailing address at the bottom of 
your email.  Add a sentence similar to this, “This email is being sent from 
ABC Company, 1234 Main St., Paso Robles, CA 93446.

-	 Provide info on how a recipient can opt-out of receiving your email 
by adding a line after your physical mailing address at the bottom of 
the email that is similar to this, “You are receiving this email because 
you or someone used this email address to subscribe to this email. To 
unsubscribe from this email, please reply with REMOVE in the subject line 
to discontinue receiving Special Offer emails from us.”

3.	Also please refer to the complete CAN-SPAM Act online to be sure you’re 
complying with all the requirements where appropriate.  Read more at: 
http://www.ftc.gov/bcp/edu/pubs/business/ecommerce/bus61.shtm
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Creating Groups of Recipients: If you’d like to create Groups of recipients to 
make selecting them much faster, follow these steps:

Choose Groups from the top left 
header of the screen, just below the 
word Email in between Campaigns and 

Template. 

You will see a blank record where you 
can enter the details for your new 
Group.

Now you can choose contacts from 
your database by clicking in the 
Member field and selecting contacts 

from your database.
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Once you have your new Group 
created (in our example, it’s called 
Current Customers), click on the 
Campaign button, then click the 
Recipients Tab, choose Add Group, and 
you’ll see the Group you just created. 
Click on the red arrow to add this 
group of contacts to the recipient list.

Click back to the Detail tab, to confirm 
everything looks good, but don’t click 
the Send button just yet.

FileMaker Pro will put all the emails in your Drafts folder. You will want to go to 
your email application, and click on the Drafts folder.  Here you can see each 
message with the personalization for First Name and any other fields you chose, 
merged into the email body.  

If everything looks good, you’re ready to send away, but read the next section 
before you press “Send” to make sure your timing is just right!
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6.	 Send Your Email
Timing of the email is important. Most only have a life of 3 days so sending early in 
the week is usually better than sending on a Friday if you’re marketing to business 
people at their offices. 

If you’re sending to homes, recent studies show that weekends, especially Sundays 
are best.   But good days for sending email change as often as the hot new color 
for Fall so just test for yourself to see what works best for you.

It’s also important to note that FileMaker Pro integrates with your existing email 
program, such as Outlook, Outlook Express, Entourage or Apple Mail to deliver 
your emails.  You’ll see all the emails that you chose to send, stacked up in your 
Drafts folder so all you need to do is click Send Now on the right day, at the right 
time.

Click Send Now at a day and time 
appropriate for your recipients.

NOTE:  Sending emails directly via an SMTP Server
If you’d prefer to send your emails directly via an SMTP server instead of through 
your email client and the Business Productivity Kit’s pre-defined templates, you can 
choose Send Mail from the FileMaker Pro File Menu, then choose Send via SMTP 
Server, and complete the rest of the screen.

Try This:
Typically, business users 
arrive on Monday morning 
to an inbox full of messages 
from the weekend. You don’t 
want your message deleted 
or partially read with the 
masses, so sending later on 
Monday or Tuesday is usually 
a good idea.
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7.	 Process Opt-Out Requests
Once your email has been sent, you should be receiving lots of phone calls, order 
replies, and visits to your website. You will also, most likely, have some customers 
who no longer wish to receive emails from you or your company.  

You must be vigilant in processing Opt-Out requests in order to keep your 
customers (and the SPAM police) happy.  Remember, just because customers 
don’t want to receive email from you doesn’t mean they won’t change their mind 
some day. So honor your customers’ wishes as quickly as possible after you send a 
message.

What to do with Opt-out Requests?
Assuming you followed the steps above in providing recipients instructions for 
Opting-out of receiving your email, you will have Opt-out requests that need to be 
processed.  Opt-out requests may come in via email, paper mail, or by phone.  The 
most common way is for recipients to reply with REMOVE or UNSUBSCRIBE in the 
subject line.  So be sure you retrieve all Opt-out requests from all channels before 
sitting down to process them.

To process Opt-out requests in FileMaker Pro, you simply need to update the 
Group and Contacts within the email Recipient tab. To do this, follow these steps:

Open the Email database that comes 
as part of the FileMaker Business 

Productivity Kit.

Click on Campaigns and go to the 
Campaign record from which the person 
is responding. In our case, it’s the 
Monthly Newsletter.
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Click on the Recipients tab. 

Click on the red x next the person’s name 
to remove them from future mailings.

Click OK to confirm the removal. 
Additionally, click on Groups, to remove 
the person from any Groups associated 
with this email.

8.	 Process Bounced Emails
Another thing that you’ll probably see are messages returned to your inbox as 
“undeliverable” due to invalid email addresses or full inboxes.  These messages 
are called, “bounces” or “bouncebacks.”

First, you will want to update the contact records for all bounced emails.  Here is 
one easy way you can do this.

You will want to add a new field to your Contacts database called, “Updated Email 
Needed?”  To do this, follow these steps:
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Open your Contacts database in 
FileMaker Pro.

Choose Manage > Database from the File 
menu so you can define a new field to 
add to your database.

Web-based services, such as 
VerticalResponse also offer 
the ability to print and send 
paper postcards to your 
customers for a reasonable 
price so you won’t have 
to bother with printing 
postcards or mailing labels.  
Learn more at  
www.verticalresponse.com
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To define the field, you need to fill in 3 pieces of 
information. The name of the field, the type of data that 
the field will store, and any comments you’d like. 

Enter “Updated Email Needed?” in the 
field name. 

Choose Text for the field type, and add 
any comments that will help you keep 
track of what this field is going to be used for.

Now that you’ve defined the field, we can add it to the 
layout.

Choose Field from the Insert menu.

Choose “Updated Email Needed?” from 
the Specify Field dialog. 

Click Create Label so your field has a 
name next to it.  Click OK.
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It might be hard to see the text depending on how your 
screen colors are set up.  If you can’t see your new field 
label, highlight the field label “Preferred Customer” 
and choose Format Painter from the Status Toolbar, and 
highlight the new field that you just added.  This will give 
it the same formatting as the Preferred Customer field so 
everything has a consistent format on your layout. 

You will see the new field added to your 
screen.   

Then you can decide how you want to get more current valid email addresses 
for the bounces. Here are some options:

1. You can resend all the bounced emails again in one month or more. This will 
give time for those that bounced due to a full inbox one more chance to get 
through. If you’re marketing to teachers during the summer, don’t resend 
again until late August.

2. You can choose to call customers and let them know that you tried to send 
the Monthly eNewsletter out as they requested, but the email address was 
not valid.  If they can give you a new one, that would be great.

3.	You can send a postcard or letter to everyone in the postal mail to ask for 
updated information. Make sure that you mail merge in the email address 
that bounced, and provide a blank where they write in their current email 
address or a link to your website or an email address where they can enter 
their information.
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To print mailing labels for postcards or envelopes, follow these steps:
Find all the records that have the update 
email field set to Yes. To do this, right click 
on a record with Yes in the Updated Email 
Needed field, and choose Find Matching 
Records.

Click Address Labels, which is in the upper 
right hand corner of the screen. And you’ll 
see the address labels on your screen ready 
to send to your printer.

If they all look good, load Avery 5160 
mailing labels in your printer, and choose 
Print from the File menu.  But don’t send 
them to the printer just yet, there’s one last 
setting you need to change so you can print 
the entire page of labels instead of just one. 

You will see a choice on the Print dialog 
that says “Copies and Pages.”  Choose 
“FileMaker Pro” from this list.  

Click Print. Then click the Continue button to 
close the on-screen label report.

You should now have picture perfect labels ready to affix to postcards or 
envelopes. 
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Speaking of postcard and envelopes…if you’d like a little help with what to 
write in the letter or postcard that requests an updated email address from your 
customers, this text should help to get you started:

Dear <First Name>,

I’m writing because I tried to send you the Big Mountain Bikes 
November eNewsletter this week, but the email address that I have 
for you below doesn’t seem to work.

Email on File:  <mail merge in email address here>

If you could take a quick minute and send me an email with your 
updated contact information to tom@bigmountainbikes.com, I will be 
sure to send you the email updates that you requested and nothing 
more. I promise to never sell or share your information.

**Win an iPod for Updating Your Info**

Plus, if you respond before the end of the month, you’ll be entered 
into a drawing for a new iPod Nano.  You will be notified if you 
won a new iPod via email so make sure you reply with a valid email 
address.

Enter by sending me an email with your contact information to:  
tom@bigmountainbikes.com

Thanks for being such a great customer <First Name>!

Happy Riding,
 - Tom and all the gang at Big Mountain Bikes!
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9.	 Follow Up
We’ve already talked about following up with customers with “bounced” email 
addresses, but following up with people who have received your email is just as 
important as following up with those who haven’t.  

There are many ways to follow up with your recipients, including sending another 
email, sending a postcard, and simply making a phone call.

1.	 Sending Follow Up Email:  Just like print advertising and television 
commercials, busy people need to see your offer many times before they 
really start to consume it. We talked about how to send emails using the 
email module that is part of the FileMaker Business Productivity, so all you 
need to do is change the urgency of the message and subject line slightly to 
something along these lines:

i.	 New Subject lines for Monthly Special Offer Follow Up emails:

Follow up Subject Line When to Send 

Last Chance for Free Tune Up
Sent 2 weeks after first email 
announcing the offer.

3 Days Left for Free Tune Up Sent 3 days before offer expires.

Final Offer for Free Tune Up – Last Day! Sent 1 day before offer expires.

2.	 Sending a Follow Up Postcard:  It’s always good to complement your email 
marketing tactics with paper-based mailers if you can afford it.  And because 
you can print mailing labels in FileMaker Pro just as easy as sending an 
email, you’ll just need to get the postcard printed, and you’ll be ready to go.

3.	 Pick up the Phone: This is always a touchy area so make sure you don’t 
violate the DO NOT CALL LIST laws, but one phone call to your customers 
where you identify yourself, and let them know that they requested to be 
sent email from your company but it’s not getting through, will most likely 
be appreciated.  If they want to give you a new address over the phone, take 
it. Or if you have to leave a message, have them call you back or visit your 
website where they can enter new information. 
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10.	Refine or Repeat
What can you learn from your first email campaign?  Here are some questions to 
ask before you produce the next one. 

1.	What worked and what didn’t? 
2.	Did you get the desired results? 
3.	Am I building relationships or are my messages ending up in Junk folders?
4.	What did my customers think of my last email?  Contact a few of them and 

find out!
5.	What can I do better next time?
6.	Do I have new names to add to my database?
7.	Do I have records that need to be updated?

Remember to continue refining your approach by learning from your own 
experiences, your customers and others, and repeat these 10 easy steps as 
needed to build a thriving email marketing program that keeps your customers 
“opening and clicking” again and again.

Conclusion
Consistent communication with your customers takes a committed effort, but it’s 
not hard if you follow the steps in this guide to get started.  

And when you’re ready, you can learn more tips and tricks to help you further 
refine your techniques through customer profiling, transactional marketing, 
measurement of open rates and click rates, automation of bounceback and opt-
out processing, A/B testing, HTML emails, and more sophisticated database 
modeling and mining. 

Until then, you should have everything you need to start email marketing the right 
way with the right tools so you can develop a successful program that strengthens 
your relationships with your customers and builds their loyalty for years to come.

Other Email Marketing and Online Resources
Be sure to download a free 30-day trial of FileMaker Pro and the FileMaker 
Business Productivity Kit at www.filemakertrial.com/bpk.

And don’t forget to visit the FileMaker Small Business Web site for more valuable 
resources to help build your business at www.filemaker.com/smallbusiness.
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You can also visit www.google.com and search on “email marketing” to find a 
wealth of information on this topic. Hmm, maybe that’s how you found this article 
in the first place?   

Additionally, here are a few sites that you should check out for more information.

•	 The FileMaker Trial website, where you can download a free 30-day trial of 
FileMaker Pro, the Business Productivity Starter Kit,  and more,  
www.filemakertrial.com.

•	 VerticalResponse, a web-based email marketing service,  
www.verticalresponse.com

•	 Information and privacy resources, www.privacy.org or www.truste.org

•	 Google.com, online search engine that sells keyword advertising,  
www.google.com

•	 Direct Marketing Association, industry organization, www.the-dma.org

•	 Direct Marketing News, industry news and mailing lists available for 
purchase www.dmnews.com

•	 Small Business Association, industry organization, www.sba.gov

•	 CAN-SPAM Act – a law passed to help protect consumers from  
unwanted email.   
http://www.ftc.gov/bcp/edu/pubs/business/ecommerce/bus61.shtm

© 2010 FileMaker, Inc.  All rights reserved.  FileMaker is a trademark of FileMaker, 
Inc. registered in the U.S. and other countries.  All other trademarks are the 
property of their respective owners. 
 
As a reminder, it is your responsibility to comply with all applicable 
laws and regulations regarding email marketing. 

This document is designed to provide general information about 
the subject matter covered, and FileMaker is not engaged in 
rendering any legal or other professional service.  If legal advice 
or other expert assistance is required, the services of a competent 
professional person should be sought.  Mention of third-party 
companies or services is for informational purposes only, and 
FileMaker assumes no responsibility with regard to the selection, 
performance or use of these companies or services. 
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Appendix 1: Exporting and Importing 
Contact Information
This Appendix contains step-by-step instructions that will help you get your 
contact information into FileMaker Pro from popular programs, such as Microsoft 
Excel, Microsoft Outlook, Microsoft Entourage, Palm Desktop, and Intuit 
QuickBooks.  

•	 Microsoft Excel

•	 Microsoft Outlook

•	 Microsoft Entourage

•	 Palm Desktop 

•	 Intuit QuickBooks

Note: These instructions are provided for the current version publicly available at 
the time of this writing. If your screens vary from the ones displayed below, please 
reference your program’s User Guide for details on exporting data.

Additionally, if the product you’re using isn’t included in this list, please reference 
the program’s User Guide for details on exporting information to Microsoft Excel 
(.xls or.xlsx), Comma Separated Values (.csv) or a Tab-delimited text (.txt) file.  Then 
follow the basic instructions below for importing contacts into FileMaker Pro.

Microsoft® Excel
FileMaker Pro can open Excel files directly, and create a brand new database from 
your Excel file instantly without requiring you to export or import the information.  
However, because we want to bring your existing Excel information into an 
existing FileMaker Pro Contacts database, you’ll want to follow the steps below.  
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Importing Contacts from Excel into FileMaker Pro 
Choose Contacts from FileMaker 
Business Productivity Solution Main 
Menu.

To do this: Open the file called 
bps_Main_Menu that’s in the folder 
called BPK_3.0 that came as part of 
the FileMaker Business Productivity Kit 
that you downloaded. (If you haven’t 
yet downloaded, please visit www.
filemakertrial.com/bpk) 

Choose Contacts from the Main Menu, 
and you will see an empty database 
that’s hungry for some names and email 
addresses!

Choose Import Records from the File 
menu, then choose File.  Change the 
“Files of type:” selection (on Windows) 
or the “Show:” selection (on Mac OS) 
to Excel Files (*.xls or .xlsx) so you can 
see all your Excel files. Browse to your 
existing Excel file with the extension 
(.xls or .xlsx) containing your names 
and email addresses. Click Open, then 
Continue.
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Drag the arrows in the right hand column to matching 
fields in the left column. Click on the arrow pointing 
to the right if you don’t want to import that field to 
FileMaker Pro. Be sure to match up the email address 
field.  It’s towards the bottom of the list at the right. Note 
that Postal Code 1 should be matched with your Zip 
code if you’re in the U.S.

Next you’ll see a screen called “Import 
Field Mapping.”  This looks intimidating, 
but if you simply go through each line 
item to match up the field names from 
your Excel file on the left with the Target 
field in FileMaker Pro on the right, you’ll 
have your names imported flawlessly.

Then click Import, and Import again.  
You’ll see a summary screen of the 
records that have been imported.

Then, you’ll see the records you imported 
on your screen.  You can browse through 
the records by clicking on the book-
like icon in the upper left section of the 
Status Toolbar.  
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Microsoft® Outlook for Windows
Exporting Contacts from Outlook 	
Different from Excel files that you can import directly into FileMaker Pro, Outlook 
files must first be exported into a format that can be read by FileMaker. 

 

To export your Outlook names and email 
addresses, first open Outlook and click 
on Contacts to see all your Contacts on-
screen. Choose Import and Export from 
the File menu. From the list of choice of 
actions to perform, choose “Export to a 
file” and click Next.

On the next screen, choose Comma 
Separated Values (Windows) and click 
Next.
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Then, choose the Contacts folder that you 
wish to export.

Be sure that you know what the file is named and where 
it’s being saved, so we can go get it shortly.

Then give the file any name, such as 
OutlookExport1.csv and Click Next.  If you 
choose the Browse button, you can save 
the .csv file anywhere you want.  

If everything looks good to you, click 
Finish. 

The Contacts will be exported from 
Outlook to a file format that can FileMaker 
Pro can import.



How to Start Email Marketing in 10 Easy Steps 33

Importing Contacts from Outlook into FileMaker Pro
To import the .csv file containing your Outlook Contacts, follow these steps:

Choose Contacts from FileMaker Business 
Productivity Solution Main Menu.

To do this: Open the file called 
bps_Main_Menu that’s in the folder 
called BPK_3.0 that came as part of 
the FileMaker Business Productivity Kit 
that you downloaded. (If you haven’t 
yet downloaded, please visit www.
filemakertrial.com/bpk) 

Choose Contacts from the Main Menu, 
and you will see some sample contact 
records that you can delete later.

Choose Import Records from the File 
menu, then choose File. Change the “Files 
of type:” selection to Comma Separated 
Text Files (*.csv, *.txt).”  Then, browse to 
your .csv file called OutlookExport1 or 
whatever name you chose above and click 
Open.
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Click on the arrow in the right hand column to move 
fields on the right to match with fields on the left. Click 
on the arrow pointing to the right if you don’t want to 
import that field to FileMaker Pro. Be sure to match up 
the email address field.  It’s way down at the bottom of 
the list at the left.

Next you’ll see a screen called “Import 
Field Mapping.”  This looks intimidating, 
but if you simply go through each line 
item to match up the field names from 
your Outlook file on the left with the Target 
field in FileMaker Pro on the right, you’ll 
have your names imported flawlessly. 

Your imported records should look similar to this 
with information from Outlook contained in all the 
corresponding fields in FileMaker Pro.

Then click Import, and Import again.  You’ll 
see a summary screen of the records that 
have been imported.

Then, you’ll see the records you imported 
on your screen.  You can browse through 
the records by clicking on the book-like 
icon in the upper left section of the Status 
Toolbar.



How to Start Email Marketing in 10 Easy Steps 35

Microsoft Entourage for Mac
Exporting Contacts from Microsoft Entourage 

Entourage files must first be exported into a format that can be read by FileMaker 
Pro. To export information from Entourage, follow these steps:

To export your Entourage names and 
email addresses, first open Entourage and 
click on the Address Book icon to see all 
your Contacts on-screen. Choose Export 
from the File menu.

On the Exports screen, choose the first 
radio button that says, “Export contacts 
to a tab-delimited text file.” Click the right 
arrow to continue.

Be sure that you know what the file is named and where 
it’s being saved, so we can go get it in a few minutes.

On the next screen, you’ll see that the 
name Contacts Export.txt has been 
chosen as the name of the exported file. 
You can leave this as is, or chose another 
name and location. 
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The Address Book data will then be 
exported from Entourage to a file format 
that FileMaker Pro can import. Click Done.

Importing Contacts from Entourage into FileMaker Pro
To import the .txt file containing your Entourage Address Book data, follow these 
steps:

Choose Contacts from FileMaker Business 
Productivity Solution Main Menu.

To do this: Open the file called bps_Main 
Menu that’s in the folder called BPK_3.0 
that came as part of the FileMaker Business 
Productivity Kit that you downloaded. (If 
you haven’t yet downloaded, please visit 
www.filemakertrial.com/bpk) 
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Choose Contacts from the Main Menu, and 
you will see some sample contact records 
that you can delete later. 

You may have also already imported or 
added some names to this database, and 
that’s ok too.  Importing more records will 
simply add names to your database and 
not overwrite contacts already in your 
database.

Choose Import Records from the File 
menu, then choose File. 
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Change the “Show” selection to “Tab 
Separated Text.”  Then, browse to your .txt 
file called EmailExport1 or whatever name 
you chose above and click Open.  

Click on the arrow in the right hand column to move 
fields on the right to match with fields on the left. Click 
on the arrow pointing to the right if you don’t want to 
import that field to FileMaker Pro. Be sure to match up 
the email address field.  It’s way down at the bottom of 
the list at the left.

Next you’ll see a screen called “Import 
Field Mapping.”  This looks intimidating, 
but if you simply go through each line item 
to match up the field names from your 
Entourage AddressBook file on the left 
with the Target field in FileMaker Pro on 
the right, you’ll have your names imported 
flawlessly. 
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Your imported records should look similar to this with 
information from Entourage Addresses contained in all 

the corresponding fields in FileMaker Pro.

Then click Import, and Import again.  You’ll 
see a summary screen of the records that 
have been imported.

Then, you’ll see the records you imported 
on your screen.  You can browse through 
the records by clicking on the book-like 
icon in the upper left section of the Status 
Toolbar.

Palm Desktop – exporting steps may vary between releases of Windows and Mac 
versions of Palm Desktop so please see your Palm Desktop documentation if these 
steps don’t match your software. These steps were created using Palm Desktop 
4.2.1 for Mac OS.

Exporting Contacts from Palm Desktop 
Palm Desktop addresses must first be exported into a format that can be read by 
FileMaker Pro.  To export your names from the Palm Desktop Address Book, follow 
these steps:
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To export your Palm Desktop addresses, 
first open Palm Desktop and click on 
Addresses to see all your Contacts on-
screen. Choose Export from the File menu.

Be sure that you know what the file is named and where 
it’s being saved, so we can go get it in a few minutes.

On the Exports screen, choose a name for 
the exported file and a location where it 
will be save.  For this example, we’re using 
the name “ContactsfromPalm” and saving 
it in the “Documents” folder, but you can 
choose any filename or location you want. 
Then click OK, and the addresses will 
be exported from Palm Desktop to a file 
format that FileMaker can import. 
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Importing Contacts from Palm Desktop into FileMaker Pro
To import the .txt file containing your Entourage Address Book data, follow these 
steps:

Choose Contacts from FileMaker Business 
Productivity Solution Main Menu.

To do this: Open the file called bps_Main 
Menu that’s in the folder called BPK_3.0 
that came as part of the FileMaker Business 
Productivity Kit that you downloaded. (If 
you haven’t yet downloaded, please visit 
www.filemakertrial.com/bpk) 

Choose Contacts from the Main Menu, and 
you will see some sample contact records 
that you can delete later.

You may have also already imported or 
added some names to this database, and 
that’s ok too.  Importing more records will 
simply add names to your database and 
not overwrite contacts already in your 
database.
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Choose Import Records from the FileMaker 
File menu, and then choose File.

Change the “Show” selection to “Tab 
Separated Text.”  Then, browse to your .txt 
file called “ContactsfromPalm” or whatever 
name you chose above and click Open.  

Click on the arrow in the right hand column to move 
fields on the right to match with fields on the left. Click 
on the arrow pointing to the right if you don’t want to 
import that field to FileMaker Pro. Be sure to match up 
the email address field.  It’s way down at the bottom of 
the list at the left.

Next you’ll see a screen called “Import 
Field Mapping.”  This looks intimidating, 
but if you simply go through each line item 
to match up the field names from your Palm 
Desktop Addresses on the left with the 
Target field in FileMaker Pro on the right, 
you’ll have your names imported flawlessly. 
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Your imported records should look similar to this with 
information from Palm Desktop Addresses contained in 
all the corresponding fields in FileMaker Pro.

Then click Import, and Import again.  You’ll 
see a summary screen of the records that 
have been imported.

Then, you’ll see the records you imported 
on your screen.  You can browse through 
the records by clicking on the book-like 
icon in the upper left section of the Status 
Toolbar.

Intuit QuickBooks
Exporting information from QuickBooks

QuickBooks lets you save information to a text file that can be imported by 
FileMaker Pro. You can save your report or list of contact items to a tab-delimited 
text file.  To export your QuickBooks contacts to a file readable by FileMaker, 
follow these steps:

1.	Display the contact list that you want to save. 
2.	From the File menu, choose Save as Text (the menu item name will include 

the type of item you are saving, like Save List as Text). 
3.	Enter a name for the file, and choose the folder where you want to save the 

document. 
4.	Choose the Tab text-delimited format.
5.	Click Save. 
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Importing Contacts from QuickBooks into FileMaker Pro
To import the tab-delimited .txt file containing your QuickBooks Contact List, follow 
these steps:

Choose Contacts from FileMaker Business 
Productivity Solution Main Menu.

To do this: Open the file called bps_Main 
Menu that’s in the folder called BPK_3.0 
that came as part of the FileMaker Business 
Productivity Kit that you downloaded. (If 
you haven’t yet downloaded, please visit 
www.filemakertrial.com/bpk) 

Choose Contacts from the Main Menu, and 
you will see some sample contact records 
that you can delete later. 

You may have also already imported or 
added some names to this database, and 
that’s ok too.  Importing more records will 
simply add names to your database and 
not overwrite contacts already in your 
database.
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Choose Import Records from the FileMaker 
File menu, and then choose File.

Change the “Show” selection to “Tab 
Separated Text.”  Then, browse to your .txt 
file with the name you chose above and 
click Open.  

Click on the arrow in the right hand column to move 
fields on the right to match with fields on the left. Click 
on the arrow pointing to the right if you don’t want to 
import that field to FileMaker Pro. Be sure to match up 
the email address field.  It’s way down at the bottom of 
the list at the left.

Next you’ll see a screen called “Import 
Field Mapping.”  This looks intimidating, 
but if you simply go through each line item 
to match up the field names from your 
QuickBooks List on the left with the Target 
field in FileMaker Pro on the right, you’ll 
have your names imported flawlessly. 
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Your imported records should look similar to this with 
information from QuickBooks contained in all the 
corresponding fields in FileMaker Pro.

Then click Import, and Import again.  You’ll 
see a summary screen of the records that 
have been imported.

Then, you’ll see the records you imported 
on your screen.  You can browse through 
the records by clicking on the book-like 
icon in the upper left section of the Status 
Toolbar.


